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Patentes y marcas registradas
La tecnología Simple Plex de ProteinSimple está cubierta por patentes emitidas y en trámite en EE. UU. y otros 
países. Para obtener más información, visite:  bio-techne.com/support/instrument-support/intellectual-property

ProteinSimple, el logotipo de ProteinSimple, Simple Plex y Ella son marcas comerciales o marcas comerciales 
registradas de ProteinSimple. Otras marcas que aparecen en estos materiales son marcas de sus respectivos 
propietarios.

Avisos de propiedad intelectual
Este manual está cubierto por las leyes de derechos de autor estadounidenses e internacionales. Ninguna parte 
de este manual puede reproducirse, modificarse o transmitirse en su totalidad o en parte de ninguna forma ni por
ningún medio, electrónico o mecánico, incluida fotocopia, grabación o cualquier sistema de almacenamiento y 
recuperación de información, sin el permiso por escrito de ProteinSimple. Por la presente, ProteinSimple concede
permiso a sus clientes que han adquirido Ella para realizar números limitados de fotocopias o copias electrónicas
de este manual sin modificaciones según puedan necesitar para su propio uso si dicho uso está restringido a los 
fines de instalar o utilizar Ella.

El software Simple Plex está sujeto a las licencias establecidas en los términos y condiciones estándar de 
ProteinSimple.

mailto:support@bio-techne.com
http://bio-techne.com/support/instrument-support/intellectual-property
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Descargo de garantía de Ella
Excepto según lo expresamente dispuesto en cualquier contrato o presupuesto de licencia de software de 
ProteinSimple, los productos vendidos y los servicios proporcionados por ProteinSimple se proporcionan 
«tal cual» y «según disponibilidad» sin garantía de ningún tipo. ProteinSimple y sus proveedores no garantizan 
la seguridad, privacidad o exactitud de ningún dato suministrado a través de los productos o servicios, y usted 
acepta que el uso de dichos datos por su parte es bajo su único riesgo. En la máxima medida permitida por 
la ley aplicable, ProteinSimple y sus proveedores renuncian a cualquier garantía, ya sea expresa, implícita o 
legal, incluida, entre otras, cualquier garantía de comerciabilidad, titularidad, no infracción o idoneidad para un 
fin particular.

Ámbito
Para que el sistema y/o todas sus piezas funcionen correctamente, las instrucciones de este manual deben 
ser seguidas estrictamente y explícitamente por personal con experiencia. Todo el contenido de esta guía 
debe leerse y entenderse en su totalidad antes de utilizar el sistema o cualquier pieza del mismo. Si no se lee y 
comprende completamente y sigue todo el contenido de esta guía antes de utilizar el sistema o piezas de este, 
pueden producirse daños en el equipo o piezas del mismo y lesiones a cualquier persona que utilice el mismo.

Finalidad prevista
La finalidad prevista del instrumento Ella es el siguiente:

El instrumento Ella es un instrumento no automatizado indicado para uso diagnóstico in vitro con un ensayo 
Ella compatible para realizar diagnósticos de inmunoensayo. El instrumento Ella secuencia el procesamiento 
de muestras, reactivos y tampones de lavado, y mide y clasifica las señales de fluorescencia utilizando un 
kit de ensayo Ella compatible. El instrumento Ella está indicado para que lo utilice personal de laboratorio 
debidamente formado.

El instrumento Ella debe utilizarse en entornos sanitarios profesionales (p. ej., laboratorios clínicos, 
hospitales, clínicas). El sistema Ella no está indicado para utilizarse en entornos cercanos al paciente ni para 
el autodiagnóstico. El uso incorrecto razonablemente previsible del producto incluye lo siguiente. 1. Uso por 
usuarios sin formación 2. Uso con cartuchos no compatibles.

Principio del test
El instrumento Ella utiliza un principio de análisis de inmunoensayo en sándwich que incluye los siguientes pasos:

En primer lugar, se captura el antígeno diana utilizando un nanorreactor de vídrio de fase sólida recubierto con un 
anticuerpo de captura específico del antígeno. La muestra se procesa a través del cartucho para unir el antígeno 
diana al anticuerpo de captura. Un anticuerpo de detección que se une al antígeno se conjuga con una etiqueta 
fluorescente y se introduce, formando así un complejo en «sándwich». Después de lavar las sustancias no 
unidas, el instrumento lee el cartucho y se notifican las unidades fluorescentes relativas. La intensidad de la señal 
es directamente proporcional a la cantidad de antígeno presente en la muestra. La concentración del antígeno en 
la muestra se puede determinar comparando la señal obtenida de la muestra con una curva estándar generada a 
partir de concentraciones conocidas del antígeno. Este principio permite la cuantificación altamente específica y 
sensible de antígenos en varias muestras.

Advertencia y riesgos residuales
No se ha identificado ninguno.



0 4W-DOC-0027 Rev B

TA B L A  //   0 1

Descripciones de las etiquetas y los símbolos

Símbolo Descripción

PRECAUCIÓN 
Consulte la documentación adjunta

Marca de aprobación NRTL 
Aprobación de seguridad eléctrica según UL61010-1:2012; EN61010-1:2010; CAN/CSA C22.2 
61010-1:2012

La garantía del fabricante de que el producto cumple los requisitos esenciales de todas las 
directivas pertinentes de la UE.

Símbolo RAEE 
Recogida selectiva para equipos eléctricos y electrónicos.

Fabricante 
Indica el fabricante del producto sanitario, tal como se define en el IVDR (2017/746).

Producto sanitario para diagnóstico in vitro 
Indica un producto sanitario indicado para utilizarse como producto sanitario para diagnóstico 
in vitro.

Número de catálogo 
Indica el número de catálogo del fabricante para que pueda identificarse el producto sanitario.

Identificador único del dispositivo 
Un código numérico o alfanumérico único que facilita el seguimiento y la identificación 
del dispositivo
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Conozca a Ella
Descripción general del sistema
Ella™ es un sistema totalmente automatizado basado en cartuchos que permite a los investigadores medir 
biomarcadores en múltiples tipos de muestras. Ella, junto con la tecnología microfluídica (cartuchos 
Simple Plex™), permite realizar mediciones de un solo analito, medir varios analitos en paralelo (multianalito) 
y también mediciones multiplexadas. Los investigadores también pueden configurar los cartuchos Simple Plex 
para que sean exclusivos para su propia investigación. 

El uso de Ella le permite: 

•	 Ejecutar automáticamente un protocolo de inmunoensayo 

•	 Adquirir y procesar datos automáticamente 

•	 Ver y analizar los datos de fluorescencia y concentración por analito y por muestra 

•	 Extraer y guardar la información de fluorescencia y concentración para el análisis específico de la aplicación 

PRECAUCIÓN: el sistema Ella no está indicado para utilizarse en entornos cercanos al paciente ni para el 
autodiagnóstico.

Especificaciones
En esta sección se describen las especificaciones de Ella, incluidas las condiciones ambientales, las 
clasificaciones eléctricas, las condiciones físicas, la clasificación láser y fusibles externos 

TA B L A  //   02

Especificaciones del instrumento

Condiciones 
ambientales

Solo para uso en interiores
Altitud hasta 2000 m (6500 pies) 
Temperatura: de 18 °C a 30 °C (de 65 °F a 86 °F) 
Humedad: 15 a 80 % HR, inclusive, sin condensación

Condiciones de 
almacenamiento y 
transporte

Temperatura: -18 °C a 50 °C (0,4 °F a 122 °F)
Humedad: HR ≤85 % sin condensación 

Condiciones físicas
Dimensiones generales: 37 cm (ancho) x 54 cm (fondo) x 26 cm (alto)
                                          14,6 pulgadas (ancho) x 21,3 pulgadas (fondo) x 10,2 pulgadas 
(alto) Peso: 18,2 kg (40,1 lb)

Fusible externo Fusible principal (entrada del aparato): 4 A, 250 V; IEC 60127 calificado como T4AL 250 V

Clasificaciones 
eléctricas

100-240 V(CA), 300 VA, 45/65 Hz, categoría de instalación de clase I (sobretensión) II 
NOTA: Los valores eléctricos indicados son nominales

Especificaciones de la 
prueba eléctrica

Esquema CB: IEC 61010-1:2010

Esquema «CUE» TÜV SÜD:
CAN/CSA-C22.2 N.º 61010-1:2012
UL 61010-1:2012/R:2019-07
EN 61010-1:2012/R:2019-07
EN 60825-1:2014

Producto láser de clase 1 según IEC 60825-1:2014 y EN 60825-1:2014

Cumple con las normas de funcionamiento de la FDA para productos láser 21 CFR 1040.10 
y 1040.11, excepto por las desviaciones de acuerdo con el Laser Notice n.º 50, con fecha 
de 24 de junio de 2007.

06W-DOC-0027 Rev B
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PRECAUCIÓN: no retire la cubierta principal del Ella; no hay componentes que el usuario pueda reparar en 
su interior y puede estar expuesto a un alto voltaje.

PRECAUCIÓN: el uso de controles, el ajuste o la realización de procedimientos distintos a los 
especificados en este documento puede provocar una exposición peligrosa a la luz láser.

Precauciones y advertencias
Las siguientes secciones describen las precauciones de seguridad que debe tener en cuenta al utilizar Ella.

Estas incluyen precauciones de:

•	 Seguridad general

•	 Seguridad eléctrica

•	 Seguridad de la luz láser

Precauciones generales de seguridad
PRECAUCIÓN: el operador de Ella debe recibir formación por parte de personal cualificado sobre el 
funcionamiento correcto del instrumento y ser consciente de los problemas de seguridad 

Precauciones de seguridad eléctrica
En esta sección se describen las precauciones de seguridad eléctrica para las conexiones eléctricas y los 
fusibles de Ella, así como los peligros por alto voltaje.

Conexiones eléctricas
Enchufe el Ella a un circuito con conexión a tierra capaz de suministrar al menos:

•	 15 amperios para una fuente de alimentación de 100 a 120 voltios

•	 12 amperios para una fuente de alimentación de 200 a 240 voltios. Consulte la etiqueta del fabricante en la 
parte posterior del Ella para obtener más información.

Fusible
El portafusibles de entrada principal se encuentra en el lado derecho de la parte posterior del Ella y contiene un 
fusible de fusión lenta de 4 A, 250 V. El portafusibles está diseñado para aceptar fusibles de 5 mm x 20 mm. La 
especificación de los fusibles de repuesto debe cumplir la norma IEC 60127 y tener una clasificación T4AL de 250V.

PRECAUCIÓN: antes de cambiar el fusible, apague el Ella y desconecte el cable de alimentación. Si es 
necesario a menudo cambiar un fusible, Ella podría tener un problema eléctrico. No utilice Ella. Podría 
exponerse a una descarga eléctrica. Póngase en contacto con el servicio técnico de Bio-Techne para 
obtener ayuda.

Precauciones y peligro por alto voltaje
El ordenador y el monitor contienen componentes electrónicos de alto voltaje. Consulte las precauciones del 
ordenador y del monitor antes de abrir el ordenador o el monitor.

Precauciones de seguridad de la luz láser

Ella es un instrumento láser de clase 1 que aloja un láser de clase 3B que funciona a una longitud de onda de 
640 nm. Bajo los procedimientos operativos especificados, Ella no permite la exposición del operador a la luz 
láser. El diseño del láser del sistema Ella cumple la norma IEC (EN) 60625-1-2014.

07W-DOC-0027 Rev B
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PRECAUCIÓN: no intente acceder al interior del Ella a través de ninguna abertura. La exposición a la 
luz láser puede causar lesiones. Por ejemplo, la exposición directa de los ojos a la luz láser puede 
causar ceguera.

PRECAUCIÓN: el uso de controles o ajustes, o la realización de procedimientos distintos a los 
especificados en este documento, puede provocar una exposición peligrosa a radiación.

Tenga en cuenta las siguientes precauciones:

•	 No retire la cubierta principal del Ella. En el interior no hay componentes que pueda reparar el usuario y puede 
exponerse a la luz láser.

•	 No siga utilizando el Ella si la cubierta principal o la tapa del cartucho se dañan y ya no son herméticos a la luz. 
Póngase en contacto inmediatamente con el servicio de asistencia de Bio-Techne para organizar la reparación.

Notificación de acontecimientos adversos
Si necesita notificar un incidente grave que se haya producido con este producto sanitario, deberá ponerse en 
contacto con el centro de fabricación (consulte el contacto del fabricante) y con la autoridad competente nacional 
del país en el que estén establecidos el usuario y el paciente. 

Cualificaciones del usuario
El personal que utilice, mantenga o limpie el Ella debe recibir formación en las prácticas de seguridad de 
laboratorio habituales y debe seguir dichas prácticas al manipular el instrumento, estar totalmente cualificado 
y formado para utilizar el sistema Ella, haber leído y entendido plenamente las instrucciones de este manual del 
usuario, y estar familiarizado con las normativas y directivas de seguridad aplicables al entorno de uso.

Instalación de Ella
Ella requiere la adecuada cualificación sobre la instalación y el funcionamiento por parte de un empleado de  
Bio-Techne formado. Ella no está listo para su uso hasta después de recibir el formulario firmado por un empleado 
de Bio-Techne que documente un procedimiento de calidad de instalación/calidad operacional.

Mover Ella
Ella es un instrumento óptico sensible y puede dañarse si se mueve incorrectamente. Si se cae, el instrumento 
puede resultar dañado. Apague siempre Ella antes de moverlo. Consulte las instrucciones de «Preparación de 
Ella para su envío» en la página 22 para obtener orientación sobre cómo preparar Ella para un traslado.

PRECAUCIÓN: este producto ha de ser levantado dos personas. Levantar objetos pesados puede causar 
lesiones. Utilice técnicas de levantamiento adecuadas.

PRECAUCIÓN: no coloque el Ella cerca de ningún dispositivo que pueda emitir vibraciones significativas 
(p. ej., un vórtex), ya que puede interferir con las mediciones.

A desechar de acuerdo con las normativas locales, regionales, nacionales, territoriales, provinciales e 
internacionales. Revise las fichas de datos de seguridad (SDS) para determinar la eliminación segura de 
materiales para su región.

Desechado de Ella
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Interconexiones: Ella a ordenador
NOTA: solo se puede conectar y controlar un instrumento Ella por PC. No se pueden conectar varios instrumentos 
al mismo PC.

1.	 Cable de alimentación de CA 
Se utiliza para suministrar alimentación de CA a Ella. El cable de alimentación de CA debe tener un conector 
hembra IEC 320 en un extremo (conexión Ella) y un enchufe macho específico del país en el otro extremo. 
Los cables de alimentación deben estar aprobados por UL y certificados por CSA con una clasificación de 
amperios que cumpla con las especificaciones eléctricas de Ella.

2.	Cable Ethernet (negro) 
Para la comunicación con la cámara de alta velocidad dentro del instrumento.

3.	Cable USB 
Para la comunicación con todas las demás capacidades del instrumento.

Interconexiones del sistema Ella
La figura 02 es una descripción general de alto nivel de las interconexiones entre Ella, el PC, el monitor, el teclado 
y el escáner de códigos de barras. Consulte las instrucciones de configuración específicas del Ella y del PC.

F I G U R A  //   0 1

Conexiones de Ella

F I G U R A  //   02

Conexión de Ella al PC y a periféricos de soporte

Cable USB

Cable Ethernet

Cable de alimentación de CA

PCElla
Cable USBCable USB

Cable Ethernet

Escáner de códigos 
de barras

Periféricos inalámbricos

Alimentación 
de CA

Alimentación 
de CA
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Requisitos mínimos de TI y hardware
No hay requisitos de red de TI para Ella. No se recomienda establecer ninguna conexión de red con Ella. Ella 
funciona como un sistema independiente y está diseñado para funcionar independientemente de una conexión de 
red. Cualquier conexión a una red, ya sea intra o interred, se realiza por cuenta y riesgo propios. 

Ella no requiere hardware adicional para funcionar. No se recomienda conectar hardware adicional a Ella, por lo 
que se hace bajo su propio riesgo.

Medidas de seguridad de TI
El cliente debe:

1.	 Controlar el acceso físico al instrumento para evitar el acceso no autorizado 

2.	Controlar el acceso al puerto USB del dispositivo solo a medios extraíbles de confianza 

Cómo ponerse en contacto con el servicio de atención al cliente
Para obtener información sobre atención al cliente o pedidos, póngase en contacto con el servicio de atención al 
cliente. Para obtener asistencia técnica, póngase en contacto con el servicio técnico.

Página web	 www.bio-techne.com/brands/proteinsimple

Servicio de 
atención al 
cliente

Teléfono	 1-408-510-5500 
		  1-888-607-9692 (llamada gratuita desde EE. UU. y Canadá solamente)

Correo electrónico	 orders@proteinsimple.com

Asistencia 
técnica

Teléfono	 1-408-510-5500 
		  1-888-607-9692 (llamada gratuita desde EE. UU. y Canadá solamente)

Correo electrónico	 support@bio-techne.com
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Capítulo 2

Inicio de Ella
Introducción
Ella es un sistema totalmente automatizado basado en cartuchos que le permite realizar inmunoensayos 
multianalito con la especificidad de un ELISA uniplex tradicional (enzimoinmunoensayo).

El uso de Ella le permite:

•	 Ejecutar automáticamente un protocolo de inmunoensayo

•	 Adquirir y procesar datos de intensidad automáticamente

•	 Ver y analizar los datos de intensidad y concentración

•	 Extraer y guardar la información de intensidad y concentración para el análisis específico de la aplicación

Componentes del sistema Ella
Ella consta de cinco componentes principales:

1.	 Instrumento/lector Ella

2.	Escáner de códigos de barras

3.	Ordenador personal

4.	Software Runner CE

5.	Cartucho de verificación (los cartuchos Simple Plex se comercializan por separado)

Ella
Un componente principal del sistema Ella es un analizador de sobremesa sin fluidos incorporados que reduce 
considerablemente los residuos y la necesidad de mantenimiento preventivo.

Diseñado con una filosofía de «cargar y procesar» en mente, Ella controla el cartucho de ensayo microfluídico 
manipulando con precisión volúmenes, caudales y patrones de flujo sin intervención humana. Después de la 
parte del ensayo de un análisis, Ella realiza automáticamente un escaneado de fluorescencia, un procesamiento 
de datos sin procesar y calcula las RFU (unidades de fluorescencia relativas) y las concentraciones por analito y 
por muestra. Con el instrumento se suministra un cable de alimentación.

Escáner de códigos de barras
El sistema Ella incluye un lector de códigos de barras portátil de uso general capaz de escanear códigos de 
barras 1D y 2D omnidireccionalmente. Cada kit de cartucho enviado desde Bio-Techne está etiquetado con un 
código de barras 2D de matriz de datos que contiene todos los datos relevantes del kit de cartucho, incluidos:

•	 Información de lote

•	 Información del panel de biomarcadores

•	 Información sobre configuración del cartucho
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F I G U R A  //   03

Cartuchos que funcionan en Ella.

PRECAUCIÓN: cualquier configuración que no emplee el software Runner CE y los cartuchos compatibles 
con el marcado CE no se ajusta a la configuración del sistema con marcado CE.  

Cada análisis de cartucho comienza escaneando el código de barras del kit de cartucho para proporcionar al 
usuario toda la información del kit de cartucho saliente y al software los datos necesarios para realizar el análisis 
del cartucho y el procesamiento de datos sin procesar.

Ordenador personal
Ella incluye un PC que le permite controlar el sistema. Se proporcionan un cable USB y un cable de red para 
conectarse con el Ella.

Software Simple Plex 
Runner CE es un sistema de software sin interfaz diseñado para analizar los cartuchos y comunicarse con una 
interfaz gráfica de usuario desarrollada por el desarrollador del ensayo. Runner CE está preinstalado en el PC 
incluido con el sistema Ella. Para obtener información o ayuda sobre el desarrollo de una interfaz gráfica de 
usuario, póngase en contacto con Bio-Techne. 

Cartucho de verificación
El cartucho de verificación se suministra como referencia reutilizable necesaria para realizar un autodiagnóstico 
del instrumento. Consulte «Autodiagnóstico de Ella» en la página 21 para obtener más detalles.

Cartuchos y ensayos Simple Plex
El cartucho IVD listo para su uso está disponible en formato multianalito de 32 muestras (consulte la figura 03). 
El cartucho se ha desarrollado con un panel exclusivo para su investigación y le permite escanear el código de 
barras, introducir las muestras y el tampón en el cartucho, colocar el cartucho en el soporte del cartucho de Ella 
y analizar el cartucho. El sistema Ella no incluye ensayos ni cartuchos Simple Plex. Utilice únicamente cartuchos y 
kits de ensayo etiquetados para su uso con el instrumento Ella. 

Cada cartucho tiene muchas entradas de muestras. Cada entrada de muestra tiene hasta 4 canales dedicados. 
Un solo canal contiene tres nanorreactores de vidrio (GNR), que se funcionalizan con anticuerpo de captura, 
de modo que se obtienen tres resultados notificables para cada analito de la muestra. El GNR contiene el 
inmunoensayo y se basa en reactivos de R&D Systems para garantizar una alta calidad y una sensibilidad 
reproducible. La recogida de GNR en un canal determinado, en una entrada de muestra determinada, en un 
cartucho determinado son la base del conjunto de mediciones producidas al procesar un cartucho Simple Plex.

Cartucho de 
verificación

V E R I F I C A T I O N  C A R T R I D G E
BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

C A L I B R A T I O N  C A R T R I D G E

DYE
25 µL

DYE
25 µL

BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

BUFFER 1mL

17 18 19 20 21 22 23 24

BUFFER 1mL

BUFFER 1mL

25 26 27 28 29 30 31 32

BUFFER 1mL

SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025

Cartucho 
de prueba y 
calibración

V E R I F I C A T I O N  C A R T R I D G E
BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

C A L I B R A T I O N  C A R T R I D G E

DYE
25 µL

DYE
25 µL

BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

BUFFER 1mL

17 18 19 20 21 22 23 24

BUFFER 1mL

BUFFER 1mL

25 26 27 28 29 30 31 32

BUFFER 1mL

SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025

Cartucho Simple Plex 32x4

32 muestras, 4 analitos

V E R I F I C A T I O N  C A R T R I D G E
BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

C A L I B R A T I O N  C A R T R I D G E

DYE
25 µL

DYE
25 µL

BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

BUFFER 1mL

17 18 19 20 21 22 23 24

BUFFER 1mL

BUFFER 1mL

25 26 27 28 29 30 31 32

BUFFER 1mL

SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025
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Inicio y apagado de Ella
Siga los procedimientos de esta sección que describen cómo colocar, encender y apagar Ella.

NOTA: al colocar el Ella, debe tenerse cuidado de que la superficie posterior tenga suficiente espacio para que 
la mano del usuario pueda acceder al interruptor de alimentación y al cable de alimentación. Con el operador 
mirando hacia la parte delantera del Ella, el interruptor de alimentación y el cable de alimentación se encuentran 
en el panel posterior, en la parte inferior izquierda.

Inicio del sistema
Para iniciar Ella:

1.	 Encienda el Ella.

2.	Encienda el ordenador y el monitor de Ella.

3.	Inicie sesión en el PC e inicie 

4.	Después de encender el Ella, se encenderá la luz 
de estado (figura 04). Consulte la tabla 3 para 
obtener una descripción de la luz de estado.

Encendido del Ella
Pulse el interruptor de alimentación del panel trasero 
del Ella.

Apagado del sistema
Para apagar Ella:

1.	 Apague el ordenador del Ella

2.	Apague el Ella pulsando el interruptor de 
alimentación del panel posterior.

TA B L A  //   03

Indicaciones de la luz de estado del Ella.
F I G U R A  //   04

Luz de estado de Ella.

Color claro Estado

● Verde Ella está encendido y listo para 
su uso

● Azul Ella está procesando un cartucho

● Parpadeo rojo
Se ha producido un error (Ella 
puede opcionalmente emitir una 
alarma audible)
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Capítulo 3

Procesamiento de cartuchos  
Simple Plex
Introducción
La siguiente sección se ofrece únicamente con fines informativos. Consulte la hoja de especificaciones y la 
documentación del producto para obtener más información sobre cómo utilizar el cartucho. 

Procesamiento de un cartucho
Para procesar un cartucho, necesitará:

•	 Sus muestras

•	 Su kit de cartucho con su etiqueta con código de barras (figura 05) que contiene:

a.	 Tampón de lavado A

b.	Componente(s) de diluyente para muestras

c.	 Cartucho

La secuencia de procesamiento típica es:

1.	 Preparar los reactivos

2.	Preparar el cartucho

3.	Configurar y procesar con Ella

F I G U R A  //   05

Kit de cartucho.

Etiquetas de código de barras
Etiqueta del kit

Se encuentra en el exterior de la bolsa del cartucho, rodeada con un círculo en la figura 05.

Kit en la caja Tampón de lavado y diluyente para 
muestras

Cartucho en la bolsa, incluida la 
etiqueta con código de barras 
(rodeado en rojo)
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Etiqueta del cartucho

La etiqueta de código de barras del cartucho (consulte la figura 06) está situada directamente en el cartucho y se 
utiliza para trazar el cartucho al kit. Esta etiqueta de código de barras del cartucho se utiliza como confirmación 
de que el cartucho que se está procesando coincide con el kit. 

Los códigos de barras de ID del cartucho se encuentran en la cara del cartucho cerca del borde inferior, como se 
muestra en la figura 06.

Preparación de muestras y reactivos
Muestras de plasma (EDTA o heparina) y suero

Las muestras de suero y plasma preparadas con el protocolo recomendado en la hoja de especificaciones del 
ensayo y que no contengan partículas visibles no requieren centrifugación adicional antes de su uso en un 
ensayo Simple Plex.

Para las muestras de suero y plasma que contengan partículas visibles, se recomienda eliminar las partículas por 
centrifugación y diluir de acuerdo con las instrucciones de las hojas de especificaciones del ensayo. El método 
siguiente está diseñado para conservar la muestra, pero puede ajustarse según sea necesario en función de 
la disponibilidad de la muestra y del contenido de partículas. El siguiente método simula la preparación de la 
muestra para la dilución mínima requerida (MRD) 1:2 utilizada en la mayoría de los análisis Simple Plex. Para 
factores de dilución más altos, puede ser necesaria una dilución seriada para una mayor exactitud.

Centrifugación para muestras de suero y plasma

1.	 Divida en partes alícuotas de 35 μl de suero o plasma en un tubo de microcentrífuga.

2.	Centrifugue a 8 000-10 000 g durante un mínimo de 4 minutos.

3.	Divida en partes alícuotas de 30 μl del diluyente de muestras adecuado en otro tubo de microcentrífuga.

4.	Una vez finalizada la centrifugación, extraiga 30 μl de muestra con cuidado de no alterar las microesferas 
del fondo.

5.	Añada los 30 μL de muestra centrifugada a los 30 μL de diluyente en alícuotas y mezcle bien.

6.	Pipetee 50 μl de la muestra diluida 1:2 en la entrada del cartucho especificada.

V E R I F I C A T I O N  C A R T R I D G E
BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

C A L I B R A T I O N  C A R T R I D G E

DYE
25 µL

DYE
25 µL

BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

BUFFER 1mL

17 18 19 20 21 22 23 24

BUFFER 1mL

BUFFER 1mL

25 26 27 28 29 30 31 32

BUFFER 1mL

SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025

V E R I F I C A T I O N  C A R T R I D G E
BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

C A L I B R A T I O N  C A R T R I D G E

DYE
25 µL

DYE
25 µL

BUFFER 1mL

1 2 3 4 5 6 7 8

BUFFER 1mL

BUFFER 1mL

9 10 11 12 13 14 15 16

BUFFER 1mL

BUFFER 1mL

17 18 19 20 21 22 23 24

BUFFER 1mL

BUFFER 1mL

25 26 27 28 29 30 31 32

BUFFER 1mL

SN 3456 2025-04-30 TNF-a 2nd gen
Car# 10:117265     VO: 9649     Date: 4/8/2025

F I G U R A  //   0 6

Códigos de barras de ID de cartucho.

Códigos de barras de ID de cartucho: Cara completa del cartucho 32x4 (izquierda). La vista de zoom detallada muestra los detalles del 
cartucho y el código de barras (derecha).
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Otros tipos de muestra

El usuario final debe determinar las diluciones óptimas.

Preparación del cartucho
NOTA: al manipular los cartuchos, se recomienda llevar guantes en todo momento y retirar el protector de plástico 
solo inmediatamente antes de colocar el cartucho en el Ella.

Procedimiento

1.	 Escanee el código de barras del kit del exterior de la bolsa de vacío del cartucho.

2.	Saque el cartucho de la bolsa de vacío.

3.	Escanee el código de barras del cartucho.

4.	Pipetee los volúmenes al cartucho en el siguiente orden:

a.	 Tampón de lavado como se describe en el prospecto del cartucho.

b.	Muestra diluida coincidiendo con el prospecto del cartucho.

5.	Desprenda el revestimiento protector de la parte inferior del cartucho.

6.	Coloque el cartucho en el portacartuchos del Ella. 
 
NOTA: después de retirar el revestimiento, tenga cuidado de no tocar la parte inferior del cartucho ni colocarlo 
sobre ninguna superficie.

7.	Cierre la pinza y la tapa del cartucho.

La secuencia para preparar un cartucho se ilustra en la figura 07.

A. Preparación del cartucho

1.	 Escaneo del código de 
barras.

F I G U R A  //   07

Guía visual paso a paso de preparación de un cartucho para procesarlo en Ella.

2.	Retirada de la carcasa 
protectora del cartucho.

3.	Escaneo del código 
de barras del cartucho 
para la confirmación 
(opcional).

4.	Carga de tampón.

5.	Carga de la muestra.

6.	Retirada del 
revestimiento 
protector/refuerzo.
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B. Cargue el cartucho en el Ella

F I G U R A  //   07

Guía visual paso a paso de preparación de un cartucho para procesarlo en Ella (continuación).

1.	 Ella con la puerta abierta.

2.	Apertura de la pinza del 
cartucho.

3.	Ella con la puerta y la pinza 
abierta.

4.	Carga del cartucho en Ella.

5.	Cierre de la pinza del cartucho.

6.	Puerta cerrándose.

PRECAUCIÓN: tenga cuidado de no derramar líquido en el nido del cartucho 

Simple Plex Runner CE
En los iconos ocultos de la barra de tareas del 
escritorio hay disponible una versión sin interfaz 
de Runner CE (consulte la figura 08). Esto puede 
utilizarse para modificar los ajustes de Runner, mover 
la fase Ella o exportar archivos de diagnóstico u otros 
datos. 

F I G U R A  //   0 8

Icono Simple Plex Runner CE.

Al hacer clic en Settings > Application (Configuración > 
Aplicación) en el menú se mostrará el cuadro de diálogo 
Settings (Configuración), como se muestra en la figura 
09. Al hacer clic en una fila del cuadro de diálogo de 
configuración se mostrará una descripción detallada del 
elemento seleccionado en la parte inferior del cuadro de 
diálogo. Estas descripciones se proporcionan en la tabla 
04 como referencia. Si se realizan cambios, se activará 
el botón Save (Guardar).

F I G U R A  //   0 9

Cuadro de diálogo de configuración de 
Simple Plex Runner CE.
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F I G U R A  //   1 0

Cambio de nombre del instrumento Ella en los ajustes de Simple Plex Runner CE.

Al hacer clic en Settings > Analyzer > Description (Configuración > Analizador > Descripción) en el menú se 
mostrará un cuadro de diálogo que puede utilizarse para cambiar el nombre del instrumento Ella (figura 10). El 
nombre del instrumento definido aquí se escribe en el software integrado del instrumento y se mantendrá incluso 
si se cambia el ordenador. Este nombre se asociará a todos los archivos .cydat producidos por el instrumento.

Parámetro Descripción

Use21CFRPart11Mode (Usar21CFRParte11Modo)
Determina si se debe utilizar o no el soporte 21 CFR Parte 11 (inicios de sesión, registros 
de auditoría, cifrado de datos, etc.). Para que este ajuste surta efecto, se debe activar el 
soporte de la Parte 11 del CFR 21.

AutoLockInactivityMinutes 
(BloqueoAutomáticoMinutosInactividad)

Determina la duración de un periodo de inactividad antes de que la pantalla de la 
aplicación se bloquee automáticamente cuando está en modo 21 CFR Parte 11. Ajuste a 0 
para desactivar esta función.

LogoutWhenDone  
(CerrarSesiónCuandoTerminado)

Cuando está en true (verdadero) (predeterminado), se cierra la sesión del usuario actual 
después de seleccionar Done (Listo) en el panel Kit Results (Resultados del kit). Cuando 
está en false (falso), el usuario actual permanece conectado y la aplicación pasa al panel 
New Kit (Nuevo Kit).

AllowOutputFilePathChange 
(PermitirCambioRutaSalidaArchivo)

Cuando está en false (falso), el nombre y la ubicación del archivo de resultados del kit no 
se pueden cambiar. Esto también se aplica al archivo de exportación LIMS genérico (si 
está activado). Este ajuste solo se aplica cuando está en el modo 21 CFR Parte 11.

KitResultsFileDefaultFolder 
(CarpetaPredeterminadaArchivoResultadosKit) El directorio común en el que se genera el archivo de resultados del kit (extensión *.cydat).

AlwaysShow3DecimalsFor Concentration 
(SiempreMostrar3DecimalesPara- 
Concentración)

Mostrar siempre 3 decimales para la concentración. El valor predeterminado es que el 
número de decimales mostrados se base en cuántos dígitos significativos hay en la 
medición. Este ajuste también cambia la forma en que se exportan los valores de 
concentración.

GnrFilter (FiltroGnr)
El filtro utilizado para seleccionar los GNR resultantes. None (Ninguno) indica seleccionar 
todas los GNR encontrados. RFU y la Concentration CV (Concentración de CV) realizan 
una eliminación de valores atípicos de GNR si el porcentaje de CV para las tres GNR está 
por encima del umbral especificado.

GnrFilterPercentCVThreshold 
(UmbralPorcentajeCVFiltroGnr) El umbral de porcentaje de CV utilizado por GnrFilter (FiltroGnr).

UseSampleStandardDeviation 
(UsarMuestraDesviaciónEstándar)

Preferencia utilizada para calcular el porcentaje de CV. Si está marcada, se utiliza la 
desviación estándar de la muestra. De lo contrario, se utiliza la desviación estándar de la 
población (la predeterminada).

ResultWarning (AdvertenciaResultado)

Este ajuste se aplica a todos los tipos de cartucho, excepto 32x8 y 72x2. Determina si un 
resultado de analito debe estar sombreado en rosa claro en la vista Results Summary 
(Resumen de resultados) cuando el porcentaje de CV relevante es mayor o igual al umbral 
especificado. Si se selecciona el ajuste Use Filter (Usar filtro), el CV y el umbral aplicables 
se determinan a partir de los ajustes GnrFilter (FiltroGnr) y GnrFilterPercentCVThreshold 
(UmbralPorcentajeCVFiltroGnr). El valor predeterminado es UseFilterSetting 
(AjusteUsarFiltro).

ResultWarningHighCVPercent 
Threshold (AdvertenciaResultado- 
UmbralPorcentajeCVAlto)

El porcentaje de CV utilizado por ResultWarning (AdvertenciaResultado). El valor 
predeterminado es 10.

ResultWarning2Gnrs 
(AdvertenciaResultado2Gnrs)

Este ajuste solo se aplica al tipo de cartucho 32x8 y 72x2. Determina si un resultado de 
analito debe estar sombreado en rosa claro en la vista Results Summary (Resumen de 
resultados) cuando el porcentaje de CV relevante es mayor o igual al umbral 
especificado. El valor predeterminado es Off (Desactivado).

ResultWarning2GnrsHighCV 
PercentThreshold (AdvertenciaResultado2Gnrs- 
UmbralPorcentajeCVAlto)

El porcentaje de CV utilizado por ResultWarning2Gnrs (AdvertenciaResultado2Gnrs). El 
valor predeterminado es 20.

TA B L A  //   04

Ajustes de Runner CE.
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Parámetro Descripción

AutoExportKitResults 
SummaryReport  
(AutoexportarInformeResumen- 
ResultadosKit)

Determina si se exportará automáticamente un informe de resumen de resultados del kit al final 
de un análisis y siempre que se guarde el archivo de resultados del kit. La ubicación y el 
nombre del archivo serán los mismos que los del archivo de resultados del kit (.cydat o .ecydat), 
excepto que la extensión del archivo se cambiará a .pdf

DemoModeEnable (ActivarModoDemo) La aplicación funcionará en modo de demostración, y no requiere un sistema Ella conectado.

KitRunDataRepositoryEnabled  
(RepositarioDatosAnálisisKitActivado)

Determina si el repositorio de datos de análisis de kits (KRDR) está activado. El KRDR incluye todos 
los datos del análisis diagnóstico de un kit, así como una copia de seguridad del archivo de 
resultados del kit. Si está desactivado, no será posible recuperar el archivo de resultados del kit.

KitRunDataRepository  
(RepositorioDatosAnálisisKit)

El directorio raíz en el que se guardan todos los datos del análisis diagnóstico de un kit, así 
como una copia de seguridad del archivo de resultados del kit. Las carpetas se organizan por 
fecha y luego por ID de kit con la hora del análisis.

LocalKitRunDataRepository 
AutoPurgeEnabled  
(AutopurgaRepositorioLocalDatos- 
AnálisisKitActivada)

Determina si los datos más antiguos de un repositorio de datos de análisis de kit (KRDR) local se 
purgan automáticamente. La función de purga automática no se aplica a un KRDR en una 
unidad de red o en un recurso compartido

LocalKitRunDataRepository 
AutoPurgeDaysToRetain  
(DíasRetenciónAutopurga- 
RepositorioLocalDatosAnálisis)

Determina el número de días de datos que se deben conservar si 
LocalKitRunDataRepositoryAutoPurgeEnabled 
(AutopurgaRepositorioLocalDatosAnálisisKitActivada) se establece en true (verdadero). El 
número predeterminado de días para conservar los datos locales de análisis de kit es de 90 días.

Generate2DMeasureScanData  
(GenerarDatosEscaneoMedición2D)

Genera datos de diagnóstico adicionales para los escaneos de medición. Aumentará el espacio 
utilizado por el repositorio de datos de análisis de kit hasta un 25 %. El valor predeterminado es 
true (verdadero).

AutoExportKitResultsTo 
GenericLIMSFile 
(AutoexportarResultados- 
KitAArchivoLIMSGenérico)

Determina si se generará o no automáticamente un archivo de exportación LIMS genérico al 
final del análisis.

GenericLIMSExportFileDefault 
Folder (CarpetaPredeterminada- 
ArchivoExportaciónLIMSGenérico)

Ubicación predeterminada del directorio en la que se genera el archivo de exportación LIMS 
genérico generado automáticamente (*.csv).

GenericLIMSAutoExport 
AppendSampleAggregateData  
(AdjuntarDatosAgregadosMuestra- 
AutoexportaciónLIMSGenérico)

Cuando está en true (verdadero), los datos agregados de muestras se anexan al final del 
archivo de exportación LIMS generado automáticamente.

GenericLIMSAutoExport 
ColumnsSameAsImport  
(AutoexportaciónLIMSGenérico- 
ColumnasIgualImportación)

Determina si el archivo de exportación LIMS genérico generado automáticamente utiliza las 
mismas columnas que el archivo de importación (si está disponible). De lo contrario, se utilizará 
el formato predeterminado.

ShowConcentrationOutOf 
RangeIndicationForExport  
(MostrarConcentraciónFuera- 
RangoIndicaciónParaExportación)

Cuando está en true (verdadero), los valores de concentración fuera de rango para las 
exportaciones LIMS genéricas se muestran como el LLOQ o ULOQ con escala de factor de 
dilución y prefijo «<» o «>» (como «<2,00» o «>5000»). De lo contrario, si está en false (falso), 
los valores de concentración fuera de rango se dejan en blanco

GenericLIMSImportFileDefault 
Folder (CarpetaPredeterminada- 
ArchivoImportaciónLIMSGenérico)

Ubicación predeterminada del directorio para elegir el archivo de importación LIMS genérico 
(*.csv).

UseGenericLIMSImportFile 
DefaultFolder 
(UsarCarpetaPredeterminada-
ArchivoImportaciónLIMSGenérico)

Determina si se debe utilizar o no el directorio predeterminado especificado en la 
GenericLIMSImportFileDefaultFolder 
(CarpetaPredeterminadaArchivoImportaciónLIMSGenérico). Si no se utiliza el directorio 
predeterminado, el directorio se establecerá de forma predeterminada en el utilizado más 
reciente.

ComPortName (NombrePuertoCom) Puerto de comunicación al instrumento.

BarcodeScannerComPortName (Nombre 
PuertoComEscánerCodigoBarras) Puerto de comunicación al escáner de códigos de barras.

BeepOnRunError (PitidoErrorAnálisis) Indica si Ella debe emitir un pitido cuando se encuentra una condición de error durante un 
análisis para atraer la atención del usuario.

RequireCartridgeBarcodeScan 
(RequerirCódigoBarrasEscánerCartucho) Requiere escanear el código de barras del cartucho en el panel New Kit (Nuevo kit).

SelfTestDataRepository 
(RepositorioDatosAutodiagnóstico)

El directorio raíz en el que se guardan todos los datos de autocomprobación. Las carpetas se 
organizan por número de Ella y, a continuación, por fecha y hora de la prueba.

TA B L A  //   04

Ajustes de Runner CE.
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Los repositorios de datos
El software Simple Plex Runner CE está configurado para almacenar los datos asociados a cada ejecución de kit y 
de autodiagnóstico. Los datos se colocan en repositorios de datos organizados por fecha y análisis.

Repositorio de datos de análisis de kits (KRDR)

•	 Proporciona una copia de seguridad/recuperación 
de CYDAT para cada análisis de kit.

•	 Proporciona datos diagnósticos en el improbable 
caso de problemas del sistema.

 Repositorio de datos de autodiagnóstico (STDR)

•	 Proporciona un historial recuperable de todos los 
procesos de autodiagnóstico.

•	 Proporciona datos diagnósticos en el improbable 
caso de problemas del sistema.

La ubicación de los repositorios puede configurarse utilizando los ajustes de la aplicación Simple Plex Runner CE.

Recuperación de un CYDAT
Si está utilizando el KRDR y ha desubicado o perdido un CYDAT de un análisis, puede recuperar el CYDAT de 
ese kit utilizando la opción Recover Kit Results (Recuperar resultados del kit) situada en el software Simple Plex 
Runner CE en File > Recover Kit Results (Archivo > Recuperar resultados del kit). Al seleccionar esta opción 
se localizará el CYDAT especificado del kit en el repositorio y se realizará una copia en la ubicación de 
almacenamiento deseada.

Exploración/recuperación de los autodiagnósticos
Si selecciona Self Test History (Historial de autodiagnósticos) ubicado en el software Simple Plex Runner CE 
en Tools > Self Test History (Herramientas > Historial de autodiagnósticos), puede ver una lista de todas los 
autodiagnósticos del repositorio organizadas por el sistema Ella y la fecha. También tiene la opción de recuperar/
guardar uno o más informes de autodiagnóstico, y pueden verse los detalles de los resultados de cualquier 
autodiagnóstico.
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Capítulo 4

Mantenimiento 
del Ella
Introducción
En este capítulo se describen las tareas de 
mantenimiento y servicio del Ella. Consulte el 
capítulo 3 para acceder al Simple Plex Runner CE.

Uso del menú de herramientas de 
Simple Plex Runner CE 

El menú Tools (Herramientas) (figura 11) se utiliza para 
mover la fase XY a ubicaciones predefinidas (debe 
hacerse con la pinza y la tapa cerradas) y exportar 
los registros del sistema de diagnóstico a un archivo 
comprimido para que lo utilice el servicio técnico.

F I G U R A  //   11

Menú de herramientas Simple Plex Runner CE.

Autodiagnóstico de Ella
El cartucho de verificación Ella permite al sistema realizar una serie de pruebas diagnósticas que garantizan 
que el instrumento funciona correctamente. El software Runner CE admite los mecanismos para realizar un 
autodiagnóstico, pero la interfaz gráfica de usuario debe ser diseñada por el desarrollador del ensayo para 
realizar la prueba. Para obtener información o ayuda sobre el desarrollo de una interfaz gráfica de usuario, 
póngase en contacto con Bio-Techne. 

Los resultados se tabularán bajo los archivos de registro del sistema. Estos resultados proporcionan al personal 
de Bio-Techne información valiosa para la solución de problemas en caso de que sea necesario realizar el 
mantenimiento del sistema. En consecuencia, recomendamos que el cartucho de verificación se procese 
semanalmente para crear un historial de funcionamiento del sistema.

El cartucho de verificación se suministró en una caja de almacenamiento como se muestra en las figuras 12 A 
y B. Siempre que manipule el cartucho de verificación, utilice guantes para evitar que se ensucie. El cartucho 
de verificación cuenta con una superficie para sellar la interfaz neumática de Ella y una superficie con 
autofluorescencia como referencia de RFU.
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Cartucho de verificación de Ella.

PRECAUCIÓN: no utilice un cartucho de verificación después de su fecha de caducidad. Esta fecha se 
muestra en el cartucho o en su certificación de calibración 

A. 
Caja del cartucho de 
verificación.

B. 
Cartucho en caja, 
código de barras 
arriba.

Uso de los comandos Mover a en el menú del software Simple Plex Runner CE 
Abra Simple Plex Runner CE
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Posición de la ventana de Objetivo 
El comando Tools > Move To > Objective Window Position (Herramientas > Mover a > Posición de la ventana de 
Objetivo) se proporciona para moverse a la posición correcta para quitar o instalar la ventana del objetivo que 
está enroscada en la placa de calefacción. 

Posición de carga del cartucho 
El comando Tools > Move To > Cartridge Load Position (Herramientas > Mover a > Posición de carga del Cartucho) se 
proporciona para volver a la posición de carga si ha pasado previamente a la posición de la ventana del objetivo o a 
la posición de envío. También se proporciona en el caso muy improbable de que el instrumento no vuelva a colocar la 
platina en la posición de carga. Si esto ocurre, póngase en contacto con el servicio técnico de Bio-Techne. 

Posición de envío 
El comando Tools > Move To > Ship Position (Herramientas > Mover a > Posición de envío) se proporciona en 
caso de que Ella se vaya a embalar para su envío.

Preparación de Ella para su envío
Para preparar Ella para el envío:

1.	 Cierre la pinza y la tapa

2.	Haga clic en Tools > Move To > Ship Position (Herramientas > Mover a > Posición de envío) en el menú 
Simple Plex Runner CE.

3.	Espere a que se cierre el cuadro de diálogo emergente Moving to shipping position (Moviendo a la posición 
de envío).

4.	Apagar Ella:

a.	 Cierre Simple Plex Runner CE haciendo clic en File > Exit (Archivo > Salir) del menú o en Close (Cerrar) (X) en 
la esquina superior derecha de la ventana de la aplicación. Cierre el software. Apague el ordenador de Ella.

b.	Apague el Ella pulsando el interruptor de alimentación del panel posterior.

Exportación de registros del sistema

Abra Simple Plex Runner CE

Al hacer clic en Tools > Export Diagnostic Data for Technical Support (Herramientas > Exportar datos de 
diagnóstico para asistencia técnica) se exporta la información de diagnóstico a un archivo zip comprimido si así lo 
solicita el servicio técnico.

Mantenimiento y limpieza
Ella requiere un mantenimiento preventivo anual realizado por un representante de Bio-Techne. De lo contrario, no 
será necesaria la calibración del usuario. Dicho esto, se recomienda realizar inspecciones periódicas del sistema. 
Tome nota de cualquier daño en la carcasa del Ella o en el aislamiento de los cables asociados. Si el daño en la 
carcasa indica que la protección de los componentes electrónicos frente a la intrusión de humedad o la luz láser 
se ha visto comprometida o que el peligro es inminente, o si el daño del cable indica que los cortocircuitos o 
las aberturas eléctricos del cable son inminentes, tome las medidas correctivas adecuadas dependiendo de la 
situación, incluida la retirada del producto del servicio hasta que se hayan realizado las reparaciones. Póngase en 
contacto con Atención al cliente para obtener información sobre reparaciones y piezas de repuesto.

PRECAUCIÓN: no utilice el sistema si el cable de alimentación está dañado de alguna manera

Los materiales necesarios para mantener y limpiar correctamente el Ella son los siguientes:

1.	 Solución de lejía doméstica al 10 %

2.	Solución de etanol al 70 %

3.	Detergente suave

4.	Paños limpios sin pelusa

5.	Toallitas desechables para lentes (opcional)
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PRECAUCIÓN: no limpie la superficie exterior con etanol.

PRECAUCIÓN: al limpiar el nido, debe tenerse cuidado de no contaminar la ventana del objetivo.

Limpieza del nido del cartucho y de la ventana del objetivo
Nido del cartucho

Si es necesario, el nido del cartucho de Ella puede limpiarse con un paño sin pelusa no abrasivo humedecido con 
etanol al 70 %. 

Ventana del objetivo

Debe tenerse cuidado para asegurarse de que la 
ventana del objetivo esté limpia. Si es necesario 
limpiarla, utilice un paño sin pelusa limpio y no 
abrasivo humedecido con un detergente suave o 
etanol al 70 % hasta que la ventana esté «sin rayas». 
Se recomienda utilizar varias toallitas de un solo uso 
para asegurarse de que la ventana del objetivo esté 
limpia (sin rayas); consulte la figura 13.
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Nido del cartucho y ventana del objetivo.

Ventana del objetivo

Nido del cartucho

PRECAUCIÓN: al limpiar la ventana del 
objetivo

•	 No utilice lejía

•	 No toque la ventana del objetivo más que 
con el paño no abrasivo

Limpieza y mantenimiento del filtro del ventilador

Ella debe recibir siempre una ventilación adecuada para el enfriamiento. Ella necesita un enfriamiento adecuado 
para cumplir las especificaciones y evitar el sobrecalentamiento. El mantenimiento periódico del instrumento 
debe incluir la inspección y limpieza del filtro del ventilador cada seis meses.

Para limpiar el filtro:

1.	 Retire el protector del ventilador y el filtro del ventilador.

2.	Aspire el filtro del ventilador para limpiarlo.

3.	Si es necesario, sustituya los filtros de los ventiladores desgastados o dañados (REF 541401).

4.	Vuelva a instalar el filtro y el protector del ventilador.

Limpieza de la superficie externa

Apague y desenchufe el Ella antes de limpiarlo. Si es necesario, limpie todas las superficies externas del Ella 
únicamente con un paño húmedo no abrasivo que puede humedecerse con un detergente suave. Además, si es 
necesario limpiar accesorios, como el cable USB o el escáner de códigos de barras, puede hacerlo, de nuevo 
utilizando solo un paño húmedo no abrasivo que puede humedecerse con un detergente suave.
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